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Introduction

Congratulations on your purchase of Bulldog Plus to manage your
Uninterru ptible Power Supply (UPS). Bull Dog Plus is designed to provide
end users the ability to take proactive steps to protect their equipment from
power related damages. Bulldog Plus allows for automatic shutdowns,
scheduled shutdowns and a variety of other features that help you manage
your system and its peripheral components.

Bulldog Plus provides detailed information about the UPS and its protected
equipment. It is easy to install and program, yet has the necessary features to
handle all of one’s power requirements. Included is the capability for network
management protocol (SNMP and DMI). Bulldog Plus will disseminate UPS
information into SNMP protocol and project it to the appropriate Network
Management Station (NMS), such as HP OpenView. To make use of
resources on the Internet, Bulldog Plus also supports HTTP protocol. This
enables end-users to monitor their UPS anywhere, anytime, by simply utilizing
their web browser.

Bulldog Plus runs in the background as a Windows service, and
communicates with the UPS in order to ensure that your computer and
attached components are protected from any power problems.

Bulldog Plus features:

1.Graceful operating system shutdown

2.Scheduled tests, shutdown/restarts of the UPS, turn on/off receptacles

3.Flexible events

4 Notification: Pager, e -mail and audible alarm, network broadcasting and
SNMP

5.Real-time values of voltage, current, frequency and loading...

6.Historical data & graph

7.Network monitoring

8.Multi-computer shutdown/restart

9.Support Simple Network Management Protocol (SNMP)

10.Support Desktop Management Interface (DMI)

11.Support HTTP, remote monitor and control using Internet browser

12.Support Universal Serial Bus (USB)

13.Multi-lingual menus
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Bulldog Plus Installation

USB(Universal Serial Bus) Setup:

HID(Human Interface Device) setup procedure

1. Whenthe USB cable is first connected to the USB port on your computer,
the Windows 98 dialog called “Add New Hardware Wizard” will appear
automatically. (To display this dialog manually, you can choose the Start
button and then Settings to access the Control Panel, and then double
click on Add New Hardware. The USB cable needs to be connected
first.)

2. The Add New Hardware Wizard dialog box guides you through the
installation process. Click on Next to move from step to step.

3. Adialog states "Windows will now search for any new Plug and Play
devices on your system". Click Next.

4. A subsequent dialog gives you these options:
Search for the best driver for your device (Recommended)
Display a list of all drivers in a specific location, so you can select the
driver you want.
Please accept the recommended choice by clicking on Next.

5.  The Wizard will then search your hard drive for a file
called ....\INF\hiddev.inf. This file contains all the information that
Windows needs to install the correct device drivers.

6.  Atthis point the Wizard might ask for the Windows CD -ROM, place the
CD in the CD-ROM drive and select OK.

7.  The installation process will continue automatically until a dialog displays
indicating that the drivers have been installed. Select the Finish button
and your drivers are installed.

Bulldog Plus Setup:
1. Place the Bulldog CD in your CD-ROM device and execute the
setup.exe to run the setup program.
2.  Check the communication type of your UPS. If you select the USB
option you must have connected the UPS to the computer and install the
HID driver.
3. During the installation, the following dialog gives you 5 options:
?? Program File: Files contain Bulldog Service, Bulldog Monitor and this
on-line help.
?? Audio Files: Some .wav files. These files will be played to notify you
when power event occurred.
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?? HTTP Files: Bulldog Plus HTTP DLL file and web pages files.
?? SNMP Files: Bulldog Plus SNMP DLL file.
?? DMI Files: Bulldog Plus DMI DLL file and MIF file.

4.  After finishing the installation, the setup process will create a Bulldog
Plus association and add the Bulldog icon to the task bar.

5. The Bulldog Plus software is comprised of two modules:

?? An UPS Monitoring Module (Bulldog Service), which runs in the
background as a Windows NT Service and communicates to the UPS.

?? An User Interface Module (Bulldog Monitor), which enables you to
control and configure Bulldog Plus through the drop down menus and
dialog boxes. It also allows you to monitor the UPS through the Main
Screen.

Setup: To modify, repair or remove Bulldog Plus from your hard disk.

Help: Bulldog Plus on-line help.

Bulldog Monitor: User interface, used to monitor and configure your UPS.

Bulldog Service: Bulldog Plus service program, used to communicate with

your UPS.

© o N O
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Bulldog Plus Service

Belkin Bulldog Service runs in the background as a Windows NT Service
when the system initiates. You can also run Bulldog Service manually by
selecting the Start Menu- Program Files - Belkin Bulldog - Bulldog Service.
Once Bulldog Service starts there is a Bulldog Service icon located on the
system tray to indicate UPS status.

1. Normal

H?ﬂczﬂw 17:39 PM

Mormal

2. UPS Disconnect, cannot get any information from UPS.

|i*EE<BEE9 1305 PM

UFS Disconnect

3. Power Failed! The UPS is operating on battery power.

||E<B@@ 1325 PM

Power Failed!
4. UPS Bypass Active!

H%@@E 13:40 PM

Boypmss

Moving your mouse over the Bulldog Plus icon in the system tray and click the
right button to pop up the following menu

v Bhow Countdown
Momndtor. ..
Configuration...
eters...

Frogram Stop
TS mes0AM
?? Show Countdown: Belkin Bulldog displays the countdown time (time
to shutdown/suspend the operating system) window to remind the user
that the operating system will shutdown or suspend in the displayed
time. This function lets the user know clearly how much time is left to

shutdown/suspend the computer when power fails. The operating
system shutdown time can be adjusted from the Action menu

00:04:42

EBEGE 12

Belkin Components

n
l.-I.. o
Letig:

=



3

Monitor: Run the Bulldog Plus user interface.

Configuration: Displays the configuration window, allows you to
change the UPS parameters.

?? Meters: Show UPS real-time meters.

?? Program Stop: If this item marked Bulldog Plus stopped. Unmark it

and the program will resume.
»

3

Once a power event has occurred, Bulldog Plus will pop up a broadcast dialog
box to inform user what happened to UPS.

16:00:35 Power Failed! The UPS powered by bafteries.
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Bulldog Plus Monitor

Bulldog Monitor enables you to control and configure Bulldog Plus through
drop down menus and dialog boxes. It also allows you to monitor the UPS
through the Main Screen. It is not necessary for Bulldog Monitor to reside in
your computer’s memory, the execution depends on the user's requirement.
This can save precious system resources.

After finishing the Bulldog Plus installation, Bulldog Service automatically
loads into memory and runs once the Windows operating system starts up.
There is a Bulldog Plus icon that lies in the system tray to indicate current
UPS status.

To run the Bulldog Monitor, moves the mouse cursor over the Bulldog Plus
icon and double -click to launch Bulldog Monitor, or click the right button to pop
up the menu:

v Show Countdown
Momator.
Configuration...
Meters.

Then select Monitor to run the program. You can also launch Bulldog Monitor
without running Bulldog Service, select Bulldog Monitor from Program Files -
Bulldog Plus menu.
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Bulldog Monitor Main Screen:
€, EELKIN BULLDOG Plus Monitor

Bwstern  Control  View  Wizard  Help

?@ )

Configure  Meters

Event Log  Histonr

CBELKIN)

JHDSf Selectiﬂn|anal=mmfzcm1?2.lﬁ.1?ﬁ.141 Model=BTUI100EE 2000 O8="Windows QBLI

UPE Health: &8
TIPS Twpe: On-Line

ey belkdn.com

TPE Model: EUTI00EE 2000
Firmware Verson: 1.0

Hozt Name: tosofzem

Fating VA: 100074
Rating Input Yolt: 110%
Rating Output Volt: 1107
Rating Battery Volt: 417

Rating Input Freg: a0Hz

L2001 1355

TestResult:  NWo Test Performed
AC Source:  Normal
Battery Btatus: Wormal

Battery Level: 100%

Loading Level: 194

26 =[Py commumcation established =

Input ‘.fcultagel Chtput Voltagel
a2

(‘ 123 41(‘ 'y
1188 f165 0% 110V }155

E_. <
ajn Tree Time Status

%‘@l!

Zeroll Receptacle Metwork
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Networking

BULLDOG Plus software is comprised of two modules: BULLDOG Service
and BULLDOG Monitor. You may run both the programs in a computer to

monitor your localized UPS or run the programs in two different computers.

1. Operation Mode:
BULLDOG Service can operate in "Master" Mode (which allows
BULLDOG to send commands to its connected UPS) in "Serial Slave"
mode (which listens to its connected UPS) or in "Networking Slave"
mode (which obtains the UPS information from Master via the network).
If two or more computers are communicating with a single UPS, only one
of these computers should be in Master mode; the others should be in
Slave mode to prevent them from sending contradictory commands.

Bullidog Plus (Master) Bulldog Plus (Metworking Slave)

Serial Line

When a power event occurs, the Master gets the information then
transmits it to Salve(s). Each BULLDOG Service executes different
"Actions"(FlexEvent) so that the system manager can configure different
strategies into each different computer. For example: When a power
failure occurs, the file server and mail server won't shutdown until the
UPS battery is low, but other lessimportant workstations execute
shutdown after 5 minutes, and the initial workstations shutdown after 10
minutes. Shutting down workstations preserves more battery power for
your mission critical network servers.

2. Remote Monitoring and Control:
Bulldog Monitor has the ability to monitor Local hosts and Remote hosts.
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Bulldog Manitar Bulldog Monitar

Bulldog Monitar

Bulldog Service Bulldog Service Metwork
Line

Local Monitor Femote Monitor

You can run only Bulldog Monitor without running Bulldog Service.
Bulldog Monitor will search hosts in the LAN(Local Area Network) which
runs Bulldog Service in the combo box. Click on the Host Selection
combo box to list the searched hosts in the LAN. Select one, then

Bulldog Monitor will connect to the selected host.
€, BELKIN BULLDOG Plus Monitor S [=] I

evstemn Control  View  Wizard  Help

ﬁEl o uilily (BELKIN)

Configure  Meters  EventLog  Historr

JlHDS1 selection | Local=tuzofzem 172.16.176.141 Model=3E2051¥110100 O8=Windows 98 LIJ

Host=tnenglezl 172.16.176.100 Model=Tnknown OS=Windows: 98 A
UPS Health: |Host=sum-sparc] 17216176144 Model=3ES651V110100 O8=Sun03 5.5.1
Host=tneng 231?2 16.176.106 MDdel—Un.kmwn 0= WmﬂustB s ]
il Host=up=web 172 16,170 153 20 ) e 2 14-4 [l
Hnst—hpups{l 17216176141 MDdel—BUlDDKR 2000 OS—HP UL B.10.20
e v Host=scokfdeltatw 172.16.176.154 Model=BUI00XE 2000  OB=3C0O_8V 3

If the host is located on the Internet, you can also input the remote host

IP address from the View Menu- Remote Hosts menu shows the hosts

you can establish connections with.
Eemote Hosts |

% Sezrch Result

Host=tengfwm 172.16.176.129 Model=Unknown OS=Windows 95 A &
B Host=sun-ultral 172.16,176,145 Model=Unknown OS=Sun0S 5.5.1
Host=sun-sparcl 172.16.176.144 Model=GESE651%110100 0O5=5unCsS
Host=upsweb 172.16.176,153 Model=BU100XR 2000  OS=Linux 2.2
------ B Host=scoke.delta.tw 172,16,176.154 Model=BUL00XR 2000 OS:
------ 5 Host=hpups0 172.16.176.147 Mode|=BU100xR 2000 OS5=HP-LI
------ g Host=upsweb2 172,16,176.155 Model=BU100XE 2000  OS=Linw:
B Host=tmpe 172.16.175.135 Model=Unknown OS=\Windows 938 A _ILI
b

iml Urrt—hammmclan 177 18 176 117 A~ —TECEN1 S i —L imdssass M0
4

¢ Connect To This [P Address
R P Comnes

3. Remote Monitoring and Control: Internet Browser.
Another way to remote monitor Bulldog Service is by using the Internet
Browser. Launch the Microsoft Internet Explorer or Netscape
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Communicator, type the IP address in the URL and press enter.

Main | Time | Status | Outlet | Meters | |Configur'e|Con1r'o|
AC Sonrce:
Utility Status: UPS current status (update every 30 seconds)
Battery Status:
Normal @
o
@
@
i@ =z
WSy @
L] @
@
@
@

You will then be able to see the UPS information. You can change the

network port number to prevent conflict with other WEB server programs.
If the port number isn't 80 you have to type URL like this:
http://172.16.176.141:2000 where 2000 is the port number you assigned.
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Bulldog Plus Monitor Operations

The Main Screen has 7 areas that present information on the operating status
of your UPS. These areas are discussed in the following sections.

.\EELHH‘I EULLDOG Plus Monitor

Main Memn <=—{Zvstem Control Yiew Wizand  Help)
Top Layer Butions <— ?El 8 il | -

Configure  Meters  EwentLogz  Historr Crmmes tinmn

Host Selction <— |{HostSelsction [Localtmsafzcm 172.16.176.141 Model-GES6S1¥110100 OS=Windows 58 = ]| Tidicshon

UPS Health: {8 . belkin.com TestResult:  Test Passed
AC Bource:  Normal
Battery &tatus: Normal

UPS Type: Line-Interactive
UPE Model: GEZE51V110100

Battery Level: 100%

Firmware Version: 001
oo i T
—— LR NE SRR Losding Level: 23%
oomation Display < Rating VA 65074
_ e IR
Fatme lipuictilt 0k TnpuiVolingsl ||| OufputValtsesl
Rating Cutput Falt: 1207 QID QID
) £
Rating Battery Volt. 127 e ( A (4 ( 332
Rating Input Freq: 60Hz 0 120v 1130 0 120V 1180

g Wz

Seroll  Receptacle Neork

Statuz

%
Time Diagram

Host Selection: Press the combo box to select hosts that runs Bulldog
Plus in the LAN. Users can monitor or control the UPS remotely
(password is needed).

Connection Indication: The logo will rotate while the communication
between Bulldog Monitor and Bulldog Service is established.
Information Display. Press Bottom Layer Buttons to change the
information that is displayed in this area.

Recent Event Log: Preserve last 10 event logs in the combo box, click
on the combo box to pull down and view the logs.

Top Layer Buttons

These buttons are used to increase the speed of your operation, refer to
the dialog boxes in the menu.

‘ﬂﬁl 8 niifin

Configure  Meters  EwentLoz  Historyr

Configuration: Same as the System-> Configuration in the menu.
Meters: Same as the View-> Meters in the menu.
Event Log: Same as the View-> Event Log in the menu.
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History Graph: Same as the View-> History Graph in the menu.

Bulldog Monitor Main Menu

The Main Screen has a menu bar at the top with 5 main options:

.\ EELEIN BULLDOG Plus Mondtor

Svstern Control  View Wizard Help

1.

System: This menu allows you to set the Bulldog Plus and
computer parameters.

Control: This menu allows you to set UPS buzzer, outlet, and test
View: The View menu allows you to see the real-time values and
history event or history data.

Wizard: Direct users to configure the most frequent use of settings,
the wizard guides users step-by-step to finish their configuration.
Help: The Help menu allows you to access the online help system.
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The system menu allows you to configure the UPS and the monitoring screen
parameters. When you select the System menu from Main Menu bar, a drop

down menu appears offering you the following menu options:

Bystern  Comtrol  Fiew
Login. ..
Configuration...
Mondtor Bereen. ..
Font k
T indow L

Close Monitor

Login: Used for Remote Monitor. User must enter the password verification
before he can control or configure the UPS.

Configuration: The Configuration menu allows you to tailor various Bulldog
Plus parameters.

Monitor Screen: Allows you to change displayed item in the Scroll Screen of
Information Display Area.

Font: Sets the font size. Bulldog Plus will resize the window automatically.
Window: This menu allows you to change the displayed items in the

Information Display Area. The items in the menu refer to each button in the
Bottom Layer Buttons.
Close Monitor: Stop Bulldog Monitor.

Password:

-

2k Cancel

When attempting to use Bulldog Monitor as a Remote Monitor (connect
to different host) you have to enter the password for verification if you
want to do such tasks as configurations, or to control the UPS.
Otherwise, you can only view the UPS information.

If user runs Bulldog Service and Bulldog Monitor on the same computer,
you can perform such configurations or control the UPS without the
password.
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To change your password, please choose the Set Password option from
Configure - Network menu

Monitor Screen

This dialog box allows you to change displayed items in the Scroll

screen of the Information Displav Area |
i1 &

Language: [

Meters: |input'oltage] jl@utput\r’altagmj
scroll'Window: & /0 Yaoltage
/O Freqguency  Step:

" BattYoltage |1 vI Second(s)

/O Current

2k Cancel |

Language: Choose a language that suits your operating system needs.
Program: Will automatically replace the on-line help file and audio files
to your selected preferences.

Meters: Press the Main button from the Bottom Layer Buttons, and you
will see that there are two meters in the information area. You can
change the displayed items of the two meters.

Scroll Window: Press the Scroll button from the Bottom Layer Buttons,
and the scroll window will display the information in this area. This item

allows you to change the display menu and its items.

Font

Bystern Control  Wiew
Login...
Configuration. ..
Monitor Screen. .

T

Tl 0 oo F v Ndedian

L
Close Monitor i

This menu allows you to change the font size of Bulldog Monitor window.
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Window
Bvstern  Control  View

Login...

Configuration...

Monitor Sereen. ..

Fomnt *

T ind oo

Close Monitor .
Time
Status
Diagran
Scroll
Chutlet
Metwork

This menu allows you to change the display items in the Information
Display Area. The items in the menu refer to each button in the Bottom
Layer Buttons.

Close Monitor

Close Bulldog Monitor and leave Bulldog Service running.
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.\ BELEIN BULLDOG Plus Configure
Devices TP Network

@ BULLDOG Flus Configmration Window

TP Commumication Port; CORE

Mext TPE Test DiatedTime: 1206/2001 12:00

2 g

2 Mezt UPE Shotdowen DaterTime: 12052001 20:00
= =
_ Nezt TEE Eestart DatedTime: 1:2/06/2001 05:00

Local Host IP: 172.16.176.141

BULLDOG Zervice Mode: bMaster

Remote Host IP:

e

The Configuration Screen has a menu bar at the top with three main options:

Devices: This menu allows you to configure the modem, pager and e-mail

applications.
UPS: The UPS menu allows you to plan and set the UPS schedule or perform

the Action...
Network: This menu allows you to choose the Master/Slave settings or

configure SNMP, HTTP functions.
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Configuration Window

UPS Communication Port: COM1, ... COM4, USB.

Next UPS Test Date/Time: The date of the next user-initiated UPS self test.
Setting from System->Configuration->UPS->Schedule.

Next UPS Shutdown Date/Time: This field displays the date of the next
shutdown the computer and UPS. Setting from

System ->Configuration ->UPS->Schedule.

Next UPS Restart Date/Time: The date of the next restart UPS. Setting from
System ->Configuration ->UPS->Schedule.

Local Host IP: IP address of a computer, which runs Bulldog Monitor.
Bulldog Service Mode: Bulldog Service acts as a Master or Slave.

Remote Host IP: The host, which runs Bulldog Service. If Bulldog Monitor and
Bulldog Service runs on the same computer and this field will be empty.
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Devices

Devices TFS  Network
Modem. ..
Wotification Taers.
Calog...

Closs

Modem
To let Bulldog Plus notify you via pager you must setup the modem device.
If you select the TAPI (Windows Telephony Application Programming
Interface) then Windows will handle the modem device, otherwise,
Bulldog Plus will control the modem device directly (AT Command).
a. COM Port: The communication port COM1, ...COMA4.
b. Baud Rate: Set the data transmitting speed.
c. Initialize String: The string, which is sent to the modem before paging is
attempted.
d. Dial Prefix: The string, which is added to the beginning of each of the
Pager Numbers before they are sent to the modem.
e. Using TAPI: Lets Windows handle the modem device.

Notification Users -- Pager List
Program will set the modem to notify all via the pager numbers, which are
listed in the pager list. You can input your pager number for your own
notification purposes. For example: 060123456 is your pager number,
each ', tells modem to delay 2 seconds, delay time is for setting waiting
period for the response signal, before proceeding to transmit to the
displayed number 119. 119 will appear in your pager LCD.
To trigger the pager notification you must enable the Pager Action in the
Action dialog box.
a. Add: Add a new pager number.
b. Modify: Modify the selected pager number.
c. Delete: Delete the selected pager number.

Notification Users -- e-mail
You can also e-mail users when power events occur. Users can choose
the way they want to send e -mails: MAPI or SMTP. The MAPI
associates with Microsoft Exchange (or Outlook) to send e-mails, so you
must run the Microsoft Outlook before BULLDOG Plus can send e-mails.
Be sure to configure a default Microsoft Exchange profile before using
BULLDOG Plus. Make sure that your e -mail name is the same as the
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name in the Outlook address book.
Notification Teers

Pager List -madl II'Ietwu:urkBmadcastl

T MAPI

ok | comel |

To trigger the e-mail notification you must enable the e-mail Action in the
Action dialog box.

a. Add: Add a new user.

b. Modify: Modify the selected user name.

c. Delete: Delete the selected user.

Notifify Users -- Network Broadcast
You can also broadcast information to users when a power event has
occurred. The broadcast function is associated with Microsoft Messenger,
so to send messages you must run under the Windows NT operating
system.
To trigger the broadcasting notification you must enable the Broadcast
Action in the Action dialog box.
a. Domain: Enable this item to broadcast to all the users in the domain,
otherwise Bulldog Plus will send messages to the hosts that users assign.
b. Add: Add a new machine name.
c. Modify: Modify the selected machine name.
d. Delete: Delete the selected name.

Color
Used to change the screen color.
a. Color Items: This area lets you select an item, which you want to
change the color for. The right-top corner will display the current
selected color.
b. Change: Change the color you selected.
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c. Default: Default setting.
d. Exit: Close the dialog box.

Close
Close the Configuration window.
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UPS

Ur: Metwork
TP Fropexty...
Attached Devices. ..
Log Management. ..
Schedule. ..

Action...
atop 411 Action

Voltage Sensitivitr. .
Transfer Voltage. ..

UPS Property
This dialog box allows you to configure the UPS COM port, battery
replacement date, ... etc. Load Warning and Load Severity used to
prevent UPS overload (see the UPS hardware user manual). In general,
Load Warning will notify the user to reduce the UPS load, Load Severity
will shutdown the computer to prevent overload.
a. COM Port: COML1, ...COM4, USB.
b. Load Warning: Load warning.
c. Load Severity: User must reduce UPS loading.
d. Last Battery Replacement Date: Records the last battery replacement
date.
e. Next Battery Replacement Date: Displays the date of the next battery
replacement, Bulldog Plus will notify the user to replace the battery.
f. Host Name: Local host name.

Attached Devices
Allows the user to assign the attached device a name. When you're
controlling the outlet, Bulldog Plus will let you know which devices you are
controlling.
a. Select an Outlet Group: Assign an outlet group. Please look at the back
panel carefully, some outlets may share one control relay, these outlets
are called an outlet group. If you turn off the outlet group (for example:
outletl and outlet2) then the UPS will stop power to the outlet group
outletland outlet2.
b. Device Name: Assigns the attached devices a name, for example:
Outlet Groupl is called Monitor for association with the monitor and Outlet
Group?2 is called Computer for as sociation with the CPU. These records
can improve the efficiency of your management. Don't forget to press
the Update button.
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c. Update: Update your change.

Log Management: (Please consider the free space in your hard disk)
a. Maximum Event Log Entries: Always Bulldog Plus to preserve less than
the assigned entries of event log.
b. Data Log Interval: Time designated for automatic saving of a record of
UPS data.
c. Maximum Data Log Storage: It allows you to save how many months
UPS data files you wish to keep.

Schedule
This function allows you to shutdown, restart, test and turn on/off outlets.
You can schedule up to 6 events. Settings are based on day, week or
month and up to a period of 2 years.
Choose the applicable schedule to set whether it be for:
a. One Time: This set schedule is applicable for a single day.
b. Daily: This set schedule is applicable for every day

c. Weekly: This set schedule is applicable for a once a week period.
d. Monthly: This set schedule is applicable for once a month period.

Schedule

SUNW | MON | TUE |WED | THR | FRI | SAT | v
- :
5 p 5 |2001 =]
10 811 15 | Month
17 [8 18 22 | |December =]
24 E 25 29
n Exit
=loe 2]ifon 2 Akl
|103E:00nds Test LI Ilg j :IDD j One Time
lShut:low ;I |2|:| Ll :||:||j Ll -
[Mone oo =]ijoo =] .
[Mene oo =]t +] ey
INOnE LI IDD j :Iljlj j Moenthly

Action
The action menu provides you with a list of events to choose from. The
event and/or any combination of these actions can be selected from the
Choose Event list box. Actions that are already enabled will show a check
mark. To delay the actions, set the desired time for delay in the Delay
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combo box.

Action

Debay: [5 ] Seconds) SetDefalt |

Shutdown...

Poweer Failed.
Porgrer Bestored —
Lo Battery

Lead Waming

Mo longer Load Waming
Lead Severity

Mo longer Load Severdty
Bypass Active

Mo longer Bypass Active
UFS Fanlt

scheduled Shotdown

UES Disconnect

UFS Connection Established
Battery Meed Replace

Test Failed

Chveload

Ohverload Reccwered

Owver Ternperhe

Oiver Ternperhie Becoversd
Fan Fatlu d

Logging...

Broadcasting...

Paging...

Command...

Alarm...

e-mail...

SNMP Trap...

XS [ ([S|[S|[x
e EEEEE

Beceptacle Control...

a. Enable Auto-Save: Bulldog Plus will save opened files and close
applications automatically when you enable this function.

b. Choose Event: When you select one item in the list the action buttons
will display current settings. Press button to do further configurations.

c. Set Default: Sets all the actions to default values.

d. Delay: The power event must stay within the delay time to trigger
actions. All the actions will be described here.

Stop All Action: Clicking on this, terminates all the actions immediately.
Action - Shutdown : Shutdown/Hibernate/Suspend the operating system
or shutdown UPS. If you select the shutdown item Bulldog Plus will
execute or ignore the Auto-Save function depending on your selection in
the Action dialog box. But if you select the “suspend” or “hibernate” item,
the program will ignore the Auto-Save function.

The action of “shutdown”, “hibernate” or “suspend” are the same as if you
select the Shutdown Option from the Windows Start menu.

Action - Logging: Allows you to log events as well as modify the default
logging message. You can see this message in the Event Log dialog box.
Action - Broadcasting: Permits you to broadcast an event based on a set
period of time. If you want to be notified once, set the time period to "0".
However, if you want to be notified more than once, set the time period to
a larger number. Each number corresponds to the number of times of
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notification.

Action - Paging: Allows you to set the time period for paging intervals. If
you want to be notified once, set the time period to "0". However, if you
want to be notified more than once, set the time period to a larger number.
Each number corresponds to the number of times of notification.

Action- Command: Permits you to execute command files and set a
period of time to delay its activation. To test this function, you can click the
Test button. To enable or disable this action, mark the Enable Command
check box.

Action - Alarm: Permits you to send out audible alarm instead of a
broadcast message. There are two alarms to select from - Buzzer and
Audio. If you choose Audio, the Bulldog Plus requires a ".wav" file to emit
the alarm. You can browse your system for other ".wav" files by clicking on
the Browse button. If you want to be notified once, set the time period to
"0". However, if you want to be notified more than once, set the time
period to a larger number. Each number corresponds to the number of
times of notification.

Action - e-mail: Permits you to send e-mails through Microsoft Exchange.
If you want to be notified once, set the time period to "0". However if you
want to be notified more than once, set the time period to a larger number.
Each number corresponds to the number of times of notification. You can
edit the user list by clicking the Edit list button, and add, modify or delete
any user name in the list. For testing this function, you can click on the
Test button. To enable or disable this action, mark the Enable e-mail
check box.

Action - SNMP Trap: Lets you send a SNMP trap when the relative power
event occurs. To enable or disable this action, mark the Enable SNMP
Trap check box. You also need to specify the SNMP Trap target hosts and
community string, please see the SNMP dialog box in the Network menu.

Action - Receptacle Control: Allows you to control the Receptacle Relay
on or off. Each Receptacle Relay may control more than one outlet, please
see the rear panel of your UPS or the UPS hardware user's manual.
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Voltage Sensitivity
Adjusts the UPS voltage sensitivity.

Transfer Voltage

Changes the low transfer voltage and high transfer voltage. This function

lets your UPS adjust to the local power environment.

a. Low Transfer Voltage: When utility power voltage drops lower than the

assigned value the UPS will switch to backup mode. The output power is

supplied from the battery.

b. High Transfer Voltage: When utility power voltage rises higher than the
assigned value, the UPS will switch to backup mode. The output power is
supplied from the battery.
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Advanced UPS Propert

Ldvanced UPE Property |

¥ Enahle Wakeup Computer

¥ Enahle Resume Computer

[~ Enahle Fower Fail, suto-Reboot
[ Enable Economic Mode

LFZS Feriodic Auto-Test

Set Default 2 Cancel

If your UPS doesn't support this function, the item will be displayed as gray
and the user cannot select this item.

Enable Wakeup Computer: If your computer architecture is compatible to ATX
and the BIOS supports RS-232(RI) Wakeup function. You should enable this
item to make the Schedule work correctly.

Enable Resume Computer: Be sure the BIOS supports RS-232(RI) Wakeup
function. When Bulldog Plus suspends the computer and the UPS detects the
change of power status, the UPS will resume the computer to its prior
operating status and let Bulldog Plus notify users.

Enable Power Fail, Auto-Reboot: The time-line describes below,

Power Eestore
Input Power Poweer Fadl
Comntdowen to Shotd own PC
Computer Shutdown PC
Backup Countdown to
ps Shutd owen TP |_
#w[TPE Restart o Tum PC on

If you enable this function, the UPS will reboot to restart the computer
otherwise, it go back to its hormal state.

Enable Economic Mode: Switches to UPS economic mode.

UPS Periodic Auto-Test: Daily, weekly, biweekly and monthly. UPS starts the
test procedure automatically when it reaches the test time.
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Wetwork

Set Password. ..
Maszter/Slave. ..
Eemote Wakeup. ..
SHME...

HTTP...

Set Password:
Sets the Bulldog Service password.

Choose Master/Slave:
Please refer to the BULLDOG Service operation mode. If the computer
connects to UPS directly (with RS-232 or USB) and can send commands
to its connected UPS then the BULLDOG Service acts as a "Master". If it
connects to UPS directly (with RS-232 or USB) but only listens to UPS
then it is a "Serial Slave". If the computer is powered by the UPS, but
obtains the UPS information from Master via TCP/IP network then it is a
"Networking Slave". When BULLDOG Service is a Networking Slave you
must assign the Master IP address so that the Networking Slave can
connect to the Master and obtain the UPS information.

a. Master: Configures the BULLDOG Service to be a Master.

b. Serial Slave: Configures the BULLDOG Service to be a Serial Slave.

c. Networking Slave: Configures the BULLDOG Service to be a
Networking Slave.

d. Master IP Address: When BULLDOG Service is a Slave you must
assign the Master IP address so that the Slave can connect to the
Master host and obtain the UPS information.

Choosz MasteriBlave

" Metworking Slave

Master [P Address:

|72 [ 18 Jwe [149

OK Conced |
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Remote Wakeup:
To wake up the remote host, Bulldog Plus sends notification through the
network. You must provide the IP address and the network hardware
address of the remote host. In Windows98, you can execute the
"ipconfig /All" command under the MS-DOS prompt to obtain the network
cards physical address of the local host. Or, input the "arp -a" command
to see the remote host’s physical address. Your network card must

support the remote wakeup feature and this function should be enabled.
Wake O LAN Edit

Hest [F Addess:
172 | 16 | [178 | [ 146

Merwork Card Hardveare Addiess:(In Hex)

| o0 | 0 | 02 | 17 o 21 | 10
Wale e up when

v wEMTEY BULLDOG Flus Resume The Comnputer From
Snspend Mode

I¥ Fach Time SENTEY BULLDOG Plus Starp

] Camerl |
a Bulldog Resume The Computer From Suspend Mode: Bulldog Plus will
reinstate the computer into normal mode, and the program will awaken
the remote hosts once the actions have been enabled.

b. Each Time Bulldog Startup: Program will wake up the remote hosts

which are enabled when Bulldog Plus starts and is connected to the
UPS.
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SNMP:
If you are using a Windows 95/98 operating system, you can
configure the SNMP parameters directly from the Bulldog Plus:
Select the Accept SNMP packet from any hosts, Bulldog Plus will accept
all the requested commands and set commands. When you select the
Accept SNMP packet from the following hosts, Bulldog Plus receives
information only from the hosts that you assigned. Once a power event
has occurred and the user enables the SNMP Trap in the Action dialog
box, Bulldog Plus will send the SNMP trap to the hosts that are listed in
the Trap Target list box. To add, modify or delete the host, click on its
respective command button

System Cuntad:lJesse Zhuo

Ok,
Swstem Name:IUPS Swstem Cancel |

& Accept SMMP packet from any hosts

 Accept SMMP packet from the following hosts

Add. | Modfy.. | Delete

— Trap Target
172.16.176.141 private

172 16.176.143 public

Modify.. |  Delete
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If you are using a Windows NT or Windows 2000 operating system,
you must install the SNMP Service and configure the SNMP
parameters from your operating system:

Bulldog Plus will ignore the values that were set in the SNMP dialog box.
To change the parameters of SNMP function, you should install the
SNMP Service in the Network option. Select the SNMP Service from the
Network option in the Control Panel and click the Property button to
make your changes.

SNMP Trap Number:

Variable Trap No,| Description
dupsCommunicationLost 1 SEVER: Communication with the UPS failed
dupsCommunicationEstablished 2 INFORMATION: Communication with the UPS reestablished
dupsPowerFail 3 WARNING: Power failed! The UPS is operating on battery power
dupsPowerRestored 4 INFORMATION: Power restored! The utility power restored
dupsLowBattery 5 SEVER: The UPS batteries are low and will soon be exhausted
dupsReturnFromLowBattery 6 INFORMATION: The UPS has returned from a low battery condition
dupsLoadWarning 7 INFORMATION: Loading percent of the UPS over the Load Warning

value

dupsNoLongerLoadWarning 8 INFORMATION: Returned from Load Warning condition
dupsLoadSeverity 9 Warning: Loading percent of the UPS over the Load Severity value
dupsNo LongerLoadSeverity 10 INFORMATION: Returned from Load Severity condition
dupsLoadOnBypass 11 | WARNING: The UPS loads on bypass
dupsNoLongerLoadOnBypass 12 | INFORMATION: The UPS is not on bypass mod
dupsUPSFault 13 | SEVER: A general fault caused in the UP S
dupsBatteryGroundFault 14 | SEVER: The UPS battery ground fault
dupsNoLongerBatteryFault 15 INFORMATION: The UPS recovered from battery ground fault
dupsTestIinProgress 16 INFORMATION: The UPS test in progress
dupsBatteryTestFail 17 | SEVER: The UPS testin progress
dupsFuseFailure 18 | SEVER: The UPS fuse failed
dupsFuseRecovered 19 INFORMATION: The UPS fuse recovered
dupsOutputOverload 20 [ SEVER: The UPS overload
dupsNoLongerOverload 21 [ INFORMATION: Recovered from UPS overload
dupsOutputOverCurrent 22 | SEVER: The UPS output is over current
dupsNoLongerOutputOverCurrent 23 INFORMATION: Recovered from UPS over current
dupsinverterAbnormal 24 | SEVER: The UPS inverter is operating abnormally
dupsinverterRecovered 25 | SEVER: Recovered from UPS inverter abnomal state
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dupsRectifierAbnormal 26 | SEVER: The UPS rectifier is operating abnormally
dupsRectifierRecovered 27 INFORMATION: The UPS recovered from abnormal state
dupsReserveAbnormal 28 [ SEVER: The UPS rectifier is operating abnormally
dupsReserveRecoverd 29 [ INFORMATION: The UPS rectifier is now operating normally
dupsLoadOnReserve 30 INFORMATION: The UPS load on reserve
dupsNoLongerLoadOnReserve 31 INFORMATION: The UPS no longer load on reserve
dupsEnvOverTemperature 32 | WARNING: The environment is over normal temperature
DupsNoLongerEnvOverTemperatu 33 INFORMATION: The environment recovered from abnormal
re temperatures

DupsEnvOverHumidity 34 | WARNING: The environment over normal humidity
DupsNoLongerEnvOverHumidity 35 [ INFORMATION: The environment recovered from abnormal humidity

HTTP:

Bulldog Plus supports WEB Server for remote management and to

obtain UPS information. User can use |IE or Communicator to connect
with Bulldog Service. Even your computer doesn't have Bulldog Plus

installed you can monitor and control your UPS via the network.

N |

Peort Mumber:

IE Srivbc\UPSentry SmartiW iR oot

IEIIII

]

a .Enable HTTP: Enable or disable the feature of Web service.
b. HTTP Root: The HTTP root path. All the html and gif files will be

located here.

c. Port Number: default port number is 80 but if there is already one
WEB server running you can change Bulldog Service HTTP port number

to a different number. At the Internet Browser you can input
http://172.16.176.141:2000 in the URL where 2000 is the assigned port

number.
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Control
Contral  ¥iew  Help

Shutd o Mo
Cancel Shutdown...

Tum Eeceptacle Relay Cn. ..
Tum Eeceptacle Relay Off.

OPE Avdible &laom Cn
UFE Andible Alarm Off

10 Beconds Test
Dieep Battery Test
Cancel Test

Shutdown Now

Shutdomen Flowe

[C Restar

& Shutdown OF and UFPS
O SHUTDOMWN O by
& BUSFEND OF Only Cancel

¢ HIEERMNATE 05 @hly

This command will execute the shutdown procedure at once.

a. Restart: This function lets you restart the OS and UPS automatically
after being shutdown. To start the OS and UPS for the next schedule,
mark the Restart check box.

b. Shutdown OS and UPS: Use this function to shutdown both the OS
and UPS.

c. SHUTDOWN OS Only: Use this function to shutdown OS only.

d. SUSPEND OS Only: Use this function to suspend your operating
system.

e. HIBERNATE OS Only: Use this function to hibernate your operating
system.

Cancel Shutdown
This menu enables you to terminate the current shutdown procedure.
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Turn Receptacle Relay On
Turns the selected receptacle relay on. Each Receptacle Relay may
control more than one outlet, please see the rear panel of your UPS or
the UPS hardware user's manual.
a. Select a Receptacle Relay: Select a receptacle relay.
b. Delay: Set the delay time to turn on the receptacle relay.
c. On: Executes the stated command.

Turn Receptacle Relay Off
Turns the receptacle relay off. Each Receptacle Relay may control more
than one outlet, please see the rear panel of your UPS or the UPS
hardware user's manual.
a. Select a Receptacle Relay: Select a receptacle relay.
b. Delay: Set the delay time to turn off the outlet group.
c. Off: Execute the turn off command.

UPS Audible Alarm On
Enables UPS buzzer. On the Bottom Layer Buttons press the Status
button to get the UPS buzzer status.

UPS Audible Alarm Off
Mute UPS buzzer alarm.

10 Seconds Test

UPS switches to backup mode and the output power is supplied by the
battery for 10 seconds.

Deep Battery Test

UPS switches to backup mode and output power is supplied by the
battery until the battery is low.

Cancel Test
This menu allows you to stop the test immediately.
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| Tiew Help
Meters. .
Event Log. ..
Hiztorr Graph. ..
Historr Data...
Auto Bave. ..

Remote Hosts...

Meters

Bulldog Plus supports up to 12 meters of real-time values. Each meter
has the ability to display all of the UPS values. Selecting different items

from the Selection dialog box will display the selected item value.
€, EELKIN EULLDOG Flus Meters

2 Batterr Level Input Frequencal Input ¥oltagel
4 100 50 a2
|
| 45 | o 150 | 25 / 75| 41 >,
v g /
= 100% 50.0Hz 11887 )
0 0 i} i ’ 100 0 ‘ 165
Selection. .
Clo Ciutput Voltagel Clotput Load 1 Temperature (F)
I g2 100 119
! I W W ! ;
25 /js 41 /;123 50 el 7 L1
= = = :
0 59 9Hz 100 a 110% 165 9 19% i . 104 4F )238

a. 2,4,6,8,12: Displayed meter number.
b. Selection: Assigns each meter to a different UPS item value.

c. Close: Closes the meter window.

Event Log

This menu offers you the ability of viewing past events.
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BELEIM SENTRY BULLDOG Plus Event Log Erint.. | it |
Dlate: | Tiroe |

(D 1200572001 13:5526 <UPS communication established 1

(D 12052001 13:55:20 <Zommect to UPS b=

412052001 13:47:23 <UFS discenmert] Cannot retdeve information from the UES =

D 12052001 13:3726 <L cad SENTRY BULLDOS Weh DLL, starp the Wehb servicebs
(1) 12052001 13:365:49 <Program starp.>

4| | e

a. Print: Print the event log.
b. Exit: Close event log dialog box.

History Graph
Clicking onthe History Graph opens a dialog box that contains
information about the UPS data in graphical format. This information is
available only if there is an accumulation of data. You can select the

month and year you want to view.
History &

rv Graph

uilly  BELEIM SENTRY BULLDOG Plus History Graph

Herizonal Scale|=0 minl - Select Mmﬂiﬁigum :_I | Decernber =]
Vealdclelsy o] | Upde Evint... | Egit |

Diraw Ieml (Blue): Dieaw Tem2{Red):
| Input Voltagel =] |Output Voliagel ~|

200

1 1
1 1
1 1
1 1
L L
1 1
1 1
1 1
1 1
1 1
r r
1 1
1 1
1 1

e e e S P e S

____.|_____'__
mmmm g —

SA0:30 H1100 511:30 HA200 H12:30 51200 5413:30 51400 SA4:30  H1500
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a. Horizontal Scale: Selects the time scale.

b. Vertical Scale: Selects the value scale.

c. Select Month: Displays the UPS data for the month, which you want to
see.

d. Draw Item1(Blue): Displays the UPS item value by a blue line.

e. Draw Item2(Red): Displaysthe UPS item value by a red line.

f. Update: Updates the graph.

g. Print: Exports the graph to printer.

h. Exit: Closes the history graph dialog box.

History Data
Clicking on the History Data opens a dialog box that contains information
about UPS data in list format. This information is available only if there is
an accumulation of data. You can select the month and year you want to
view.

Hiztory Data

Selected kManth: |1999 j IJune j deatel Expu:urt...l Erint... | Exit
Date Time [Battery Voltage [Battery Current [Battery Level [nput Frequ = |
13 062319991242 [40.8 L1000 Bo.0
14 D6-23-1999)12:45 408 L1000 599 [l
15 D6-23-1999)12:44 408 L1000 599
16 062319991245 [40.8 L1000 59.9
17 D6-23-1999)12:46 |40.5 L1000 599
16 D6-23-1999)12:47 408 L1000 599
19 06-23-199912:45 [40.8 L1000 Bo.0
20 D6-23-1999(12:49 |40.8 L1000 599
21 D6-23-1999(12:50 |40.5 L0000 600
22 D6-23-1999(12:51 |40.5 L1000 59.9
23 D6-23-1999(12:52 |40.8 L1000 599
24 D6-23-1999(12:53 |40.8 L0000 600 -
Kl _'I_I

a. Select Month: Displays the UPS data in the month, which you want to
see.

b. Update: Updates the list.

c. Save As: Saves the data in the list format to the file that you assigned.
d. Print: Export the list data to printer.

e. Exit: Closes the history data dialog box.

Auto Save
When certain power events occur, Bulldog Plus will save open files and
close applications before shutting down the operating system. If these
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saved files are untitled, Bulldog Plus will assign file names for them and
put the files in temporary directory. This dialog box will tell you which
files were saved by Bulldog.

a. Program Title: The application’s title name.

b. Auto-Save File Name: Bulldog Plus names the file for you.

c. Clear: Clear this record.

Remote Hosts
Detect the hosts, which are running the Bulldog Service in the LAN. You

can also type in the IP address and connect to the WAN.
Eemote Hosts |

+ Search Result

Host=msupcfg 172.16.176.62 Model=GES5015110 C5=\Windows ! ;|
Host=thge 172.16.176.70 Model=Unknown OS=wWindows 98 A
B Local=msofzcm 172.16.176.141 Mode|=BLU100XE 2000 DS =\ indo
Host=sun-sparcl 172,16,175.144 Model=5ES651%110100 OS=Sun0S
Host=tn=ofekas 172.16,.176.146 Model=GES6515110 OS=\Windows 2C
Host=t=uplpu 172.16,176.59 Model=Unknown OS=\Windows 98 A
B Host=mengysf 172.16.176.48 Model=Unknown COS=\Windows 98
Host=mengadd 172.16.176.113 Model|=GESS01S OS=\Windows 93 j'LI
=N
3

et —1 imesiee I 177 15 174 152 RdeAdmd —1 mlemmnans 0T — 1 e e T3 1 A2

" Conneet To This [P Address
{1 Conner

a. Search Result: The hosts will be listed in the Search Result list box.
Select the host you want to connect to and press the Connect button to
establish the connection.

b. Connects to this IP address: Bulldog Plus will connect to the IP
address, which you type in.

c. Connect: Establish the network connection.
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Bottom Laver Buttons

Each button shows the respective information in the Information Area

%%‘@l!

Main Tree Time Statnz Scmoll - Receptacle  Network

Main: General Information about the UPS.

Tree: There are 2 sub-trees in the Bulldog Plus tre e: System and UPS. The
System tree is for host information and the status of Master/Slave connection.
The UPS tree is for all other UPS information.

Time: Displays the time for all schedules, battery replacement date and
countdown time.

Status: UPS status.

Diagram: Indicates the UPS current flow.

Scroll: UPS data graph.

Outlet: Displays outlet status. (If your UPS cannot control the outlet then this
button disappears)

Network: Indicates the connection of Master/Slave, Bulldog Monitor and
Bulldog Service.

Main
UPS Health: 3 levels: Green, yellow and red.
UPS Type: On line, off line, line interactive or 3 phase on line.
UPS Model: The UPS model, which is being monitored by Bulldog Plus.
Firmware Version: Indicating the version status of the UPS inte rnal code.
Host Name: The host, which runs Bulldog Plus.
Rating VA: The UPS rating VA.
Rating Input Voltage: The UPS rating input voltage.
Rating Current: The UPS rating current.
Rating Battery Voltage: The UPS rating battery voltage.
Rating Input Frequency: The UPS rating input frequency.
Test Result: Results of the last self-test.
AC Source: Normal, battery or bypass.
Battery Status: The status of battery.
Battery Level: Percentage of battery level.
Loading: Output loading percentage.
Bulldog Plus with the ability to change the display item of the meters, the
referred menu item: System-> Main Screen.
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UPS Tree
System: System tree for host information and the connection of
Master/Slave.
UPS: UPS tree for all of the UPS information.

Time
Last Battery Replacement Date: To change the date of last battery
replacement in the System-> Configuration UPS->UPS Property.
Next Battery Replacement Date: To change the date of next battery
replacement in the System-> Configuration UPS->UPS Property.
Next 10 seconds Test Time: System -> Configuration UPS-> Schedule.
Next Deep Test Time: System-> Configuration UPS-> Schedule.
Next Shutdown UPS Time: system->Configuration UPS-> Schedule.
Next Restart UPS Time: System-> Configuration UPS-> Schedule.

Status
Shows all of the UPS statuses, red light indicates this event happened.

Diagram
Input and output power flow of UPS.

Scroll
Records the most recent UPS data information. You can change the
displayed item from System->Main Screen.

Outlet
Displays the UP S outlet status (If your UPS cannot control the outlet this
button disappears).

Status: ldentifies the current outlet status: Normal or shut.
Next Turn Off Time: System->Configuration->UPS->Schedule

Next Turn On time: System ->Configuration->UPS->Schedule

Network
Displays all the Bulldog Services searched nn the LAN.
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